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1 Introduction 
 
Over the past 10 years, the volume of spatial information generated by CIFOR is enormous, and 
the number of sources of information is equally overwhelming. Increasingly, such information 
is published using electronic means, but a substantial part of it remains inaccessible to users. 
The major problem facing information-seekers is the location of information sources 
corresponding to their needs.   
 
Equally important, information-providers often do not easily find appropriate media for 
presenting their information, which then remains inaccessible to others. It is significant to solve 
the problem of "hidden" data for that accessible data will stimulate the efficient use of it and 
therefore removes the redundancy and improves the quality of the work performed by CIFOR in 
general, the research divisions and last but not least the GIS Unit. 
 
In 2003 the GIS Unit started an initiative to address this issue by creating a centralized spatial 
database, in which each project can store, access and retrieve their own data. This approach 
provides a framework for authorized users to see what kind of data is available and where to 
find it.  
 
In order to introduce the system to the GIS audience in CIFOR and ICRAF, a half day 
workshop is planned to provide an overview and give hands-on exercises on: 
• how to connect to the spatial database; 
• how to submit your data into the database; 
• how to use the metadata editor to create metadata; 
• and to provide an introduction to the Forest Spatial Information Catalog (FSIC). 
 
We will hope that you will find this workshop useful and that you will start to see the 
advantages of using a centralized spatial database. Any questions, please get in touch. We look 
forward to meeting you all in the GIS unit on the 21st of January. 
 
Best regards, 
 
 
 
Joris Siermann, Atie Puntodewo & Andy Darmawan 



GIS Unit – Spatial Data Management Workshop Manual 
Version 1.3 

Page 5 
  

2 ArcView Database Access 

2.1 Introduction to ArcView Database Access 
 
ArcView ® Database Access extension lets you bring data from your relational database 
management system into ArcView GIS, where you can use it to solve spatial problems. This 
manual will help you understand how you can use ArcView GIS software’s main components. 
 
You don’t need to be experienced with ArcView or relational databases to start using the 
Database Access extension. This manual covers the ArcView basics and helps you get 
acquainted with relational database concepts. 
  
The database access extension supports connections to SDE 3 and ArcSDE 8 servers. 
Information and instructions pertaining to SDE throughout this book can also be applied to 
ArcSDE 8 servers. 
 

2.1.1  Using the Database Access extension 
Your database contains many tables of data whose subjects are related to each other. You could 
have a table with property information, and several lookup tables describing codes in the 
property information table. Database Access lets you see the contents of these tables using an 
ArcView database table. 
 

 
 
Database tables are created using Structured Query Language (SQL) Select statements, which 
choose the columns and records of data you want to see from the tables in your database. You 
don’t need to know SQL to see your data in ArcView. The Database Access extension provides 
a wizard that will walk you through the steps of choosing the data you want to see. When you’re 
comfortable writing your own SQL Select statements, you’ll be able to combine columns of 
data, summarize groups of records, and sort the records you get by more than one column. 
 
Once you have a database table in your project, you can join it to other ArcView tables such as a 
shape file’s attribute table. If you’re not satisfied with a database table’s contents, you can 
change its query. 
 
With software like Spatial Database Engine™ (SDE™) or ArcSDE 8 from Environmental 
Systems Research Institute, Inc. (ESRI), you can create a spatial database that has land parcel 
shapes in your property information table. Database Access lets you add the land parcels in your 
database to an ArcView map using a database theme. 
 
Database themes are created using queries that can retrieve shapes from the database. You can 
build those queries using the wizard. Walking through the wizard, you could, for example, join 
the property information table and the owners table to a table of zip code shapes, then create a 
zip code theme containing data from all three tables. 
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When a database theme is part of a map, you can change its projection, classify land parcels by 
their attributes, and locate specific land parcels. 
 

2.1.2  Before you start to load the ArcView Database Access 2.1 b 
Before you can begin the ArcView extension Database Access 2.1 b, you need to find out some 
information and make sure your machine is set up correctly. 
 
Find out who the SDE database administrator is in your organization, and then arrange some 
time to ask the following questions.  
• What is the name of the SDE server I’m connecting to? 

The SDE server is the machine that has your data. 
• What is the name of the SDE database instance I’m connecting to? 

The SDE database instance is the SDE process that lets you access a set of spatial data. 
• What user name and password do I use to access the data? 
 
See Appendix I for the database connections properties. Now you have all the information you 
need to start using SDE data in ArcView. 
 

2.1.3  Getting on-line help 
To find out what a button, tool, or menu choice does 
Move the cursor over it but do not select it. A short description will appear in the ArcView 
status bar. 
 
To get more help about a button, tool, or menu choice 
1. Click the Help button. 
2. Click the button, tool, or menu choice you want to get help about. 
 
To get help about a dialog box 
Press the F1 key on your keyboard when the dialog is displayed. 
 
To browse the contents of ArcView’s help 
1. From the Help menu, choose Help Topics. 
2. Click the Index tab. 
 
To search ArcView’s help for a particular word 
1. From the Help menu, choose Help Topics. 
2. Click the Find tab. 
 
Note If you use the Index or Find to locate topics in the on-line help, check the topic to make 
sure it belongs to the Database Access extension. All help topics for the extension have the 
name Database Access in the title or the first line of the topic. 
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Getting technical support from ESRI 
Please see the software registration and support card that came with ArcView, or look at the 
‘Obtaining technical support’ section of ArcView software’s on-line help. 
 
Visit ESRI on the Web 
Find out everything you want to know about ESRI ® software, data, and services by visiting 
ESRI’s Web home page at www.esri.com. 
 

2.2 Make A Map Using Simple Database Themes 
 
Exercise 1 in this part is the basics of creating a map with SDE data. To follow the exercise, 
you need access to the SDE database containing Malinau Research Forest site, rivers, roads, and 
villages for Malinau district. Appendix 1. Connections Properties in this manual provide 
information to access the SDE database 
 
Suppose you were asked by your supervisor to make an overview map of Malinau Research 
Forest for a planned field trip into some villages. What would you do? The first step in solving 
this problem is to bring all your data together in an ArcView map. In exercise 1, you’ll learn 
how to: 
• Load ArcView extension software. 
• Create new database themes. 
• Identify a feature in a map. 
• Change the color of a theme. 
• Save your work. 
 
Start ArcView. Before you can start assembling a map, you need to load the Database Access 
extension. Loading the extension makes the required components available for connecting 
ArcView to an SDE database and working with SDE data. 
 

2.2.1 Load ArcView extensions 
1. Make the Project window active. 
2. From the File menu, choose Extensions. 
3. Click the check box next to Database Access. 
4. Click OK. 
 
You’ll create the map by adding the Malinau Research Forest site, rivers, roads, and villages 
together. The steps below show how to add simple database themes to your map. 
 

2.2.2 Add simple database themes 
1. In the Project window, double-click on Views  to create a new map. 
2. From the View menu, choose Add Database Theme. The SQL Query Wizard dialog 

appears. It will guide you through the steps of adding database themes to your map. 
3. Click Create a new connection, then press Next. 
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4. First, type the appropriate information into the Server: Instance, Username, and Password 
text boxes. (If you don’t know what to type, read Appendix 1. Connections Properties.) Be 
careful when you type; SDE is case sensitive with these text strings. Second, click Connect. 
When the Connect button is dimmed out, you’ve successfully connected to the SDE server. 
Third, choose the database containing the Malinau Research Forest site, rivers, roads, and 
villages data. Continue by pressing Next. 
 

 
 

5. Choose the cifor_mrf_site, cifor_malinau_rivers, cifor_malinau_roads_v3, and 
cifor_malinau_villages spatial columns from the list (hold down SHIFT and click on them). 
The list won’t show the names “cifor_mrf_site”,  “cifor_malinau_rivers,” 
“cifor_malinau_roads_v3”, and “cifor_malinau_villages”. The cifor_mrf_site spatial 
column will look something like “workshop.gisuser.cifor_mrf_site.shape”. In this example, 
the user “gisuser” owns the table “cifor_mrf_site”, which has a spatial column called 
“shape”. 
Continue by pressing Next. 

 

 
 
6. Click Create a theme(s) from the selected set(s) of features, and then press Finish. Your map 

now contains four database themes, which are named for their spatial column. 
7. Draw the themes by clicking the check box next to the theme names in the map’s Table of 

Contents. Make sure that the themes orders are villages, roads, rivers, and mrf_site. You can 
change the order by dragging themes up or down in the Table of Contents. 
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8. Change the names of the themes to Villages, Roads, Rivers, and Malinau Research Forest 

respectively. First, make the theme active by clicking on its name in the map’s Table of 
Contents, and then click the Theme Properties button . In the Theme Name text box, type 
the appropriate name. Click OK. 

 

2.2.3 Identify a feature in a map 
1. Make the theme whose features you want to identify active by clicking on its name in the 

map’s Table of Contents. 
2. Click the Identify tool . 
3. Click on one of the features you want to identify. The feature you click on flashes in the 

map, and its attributes appear in the Identify Results dialog. 
 
Now that the map contains the required data, start customizing the way it looks. You can change 
the colors of the themes, the map’s projection, and the themes’ display properties. 
 
The theme’s colors were randomly assigned when the themes were created. To change their 
colors, use the Legend Editor. 
 

2.2.4 Change the color of a theme 
1. Make Villages, Roads, Rivers, and Malinau Research Forest themes active by holding down 

the SHIFT key while clicking on their names in the map’s Table of Contents. 
2. Click the Legend Editor button . 
3. Choose a theme’s name from the Theme drop-down list. 
4. Double-click the symbol to display the Symbol Window. 
5. In the Symbol window, click the Color button  to display the Color Palette. 
6. In the Color Palette, click the color you want to use for the theme. 
7. Click Apply in the Legend Editor. 
8. Repeat steps 3–7 for the other themes in the Theme drop-down list. 
9. Close the Legend Editor and the Symbol Window. 
 

2.2.5 Save your work 
1. From the Window menu, choose Untitled to make the Project window active. 
2. From the File menu, choose Save Project. 
3. In the dialog that appears, specify a name (e.g., GIS Workshop) and location for the new 

project file, then click OK. ArcView will automatically add the .apr extension to the name 
you gave for the new project file. 

 
When you save your project, ArcView doesn’t store the theme’s values in the project; it stores 
the query used to get the values from the database. If you close your project now and open it 
again later, you will be prompted to log in. When you do, ArcView will re-establish its 
connection to the database and retrieve the shapes and values for the themes in your map. 
 



GIS Unit – Spatial Data Management Workshop Manual 
Version 1.3 

Page 10 
  

3 ArcCatalog 

3.1 Introducing ArcCatalog 
 
ESRI ® ArcCatalog software makes accessing and managing geographic data easy. First, you 
add connections to the geographic data you work with to the Catalog. You can connect to 
folders on local disks, to shared folders and databases that are available on the network, or to 
Internet map servers. 
 
After building your Catalog, you can search for the data you need and explore the search results 
using the different views that are available. In ArcCatalog, you can work with all data the same 
way regardless of the format in which it is stored. Several tools are also available to help you 
organize and maintain your data. For a cartographer, it’s never been easier to ensure you’re 
adding the right data to your maps. And, whether you’re an analyst managing your personal data 
holdings or an administrator managing those of a large organization, ArcCatalog simplifies the 
job. 
 

3.1.1 What can you do with ArcCatalog? 
Browse for maps and data 
Select a folder, database, or Internet server in the Catalog tree, and then examine the list of 
geographic data it contains in the Contents tab. You can change the appearance of the Contents 
list using buttons on the Standard toolbar. Switch your view from large icons to small icons, or 
list properties and metadata for each item to help you decide which is the right one to use. 
Thumbnail view lists snapshots illustrating the geographic data contained in each item in the 
folder, database, or Internet server. 
 

 
 

Explore the data 
Thumbnails give you a quick look at the contents of an item, but you may want to check 
whether or not a specific feature in coverage has been updated. Select an item that contains data 
in the Catalog tree and then examine its data using the Preview tab. 
 
Look at geographic data with Geography view. Buttons and tools on the Geography toolbar let 
you zoom and pan to explore the features in a computer aided design (CAD) drawing, cells in a 
raster, or triangles in a triangulated irregular network (TIN). The Identify tool lets you click a 
feature, cell, or triangle and see its attributes. 
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With Table view, you can see the attributes of a geographic data source or the contents of any 
table in a database such as inventory or billing data. Explore the table’s contents by rearranging 
its columns, sorting its rows using the values in one or more columns, or searching for specific 
values. 
 

 
 
View and create metadata 
Before deciding to use a data source in a map, you may need more information. In the 
Properties dialog box for a data source, you can find its coordinate system and the data type of 
each attribute. However, for information such as why the data was created, the appropriate scale 
at which to use the data, a data accuracy report, or a description of what an attribute name 
means, you must look at its metadata. 
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ArcCatalog comes with a metadata editor that you can use to document your data. The Catalog 
will fill in as much information as it can using the data’s properties. When the data changes for 
example, when a new attribute has been added the next time you look at the metadata the 
Catalog automatically updates it with the new information. Metadata is an integral part of the 
data and will follow when the data is copied or moved to a new location. 
 
Use data in ArcMap and ArcToolbox 
After finding the map you want to use, double-click it to open it in ArcMap. Add data to the 
map by dragging it from the Catalog for example, dragging it from your search results and 
dropping it on the map. In addition to creating printed maps, ArcMap is where you go to edit 
geographic and tabular data. 
 
Instead of adding the data to a map, you may want to convert the data you’ve found to a 
different format or buffer its contents. After opening a geoprocessing tool or wizard in 
ArcToolbox, you can drag the data source from the Catalog and drop it onto the tool. The 
Toolbox automatically fills in as many options in the tool as possible. If you use a group of tools 
frequently, you can customize ArcCatalog by creating a new toolbar and adding these tools to it 
for quick access. 
 
Manage data sources 
After looking at the contents of a data source and reviewing its metadata, you might want to 
modify it to better suit your needs. You can manage the structure of a data source using the 
Properties dialog box. For example, the Properties dialog box can be used to define a shapefile's 
coordinate system, generate a coverage’s topology, or add an attribute to a table. You can also 
create a relationship class that defines the relationships between the features in coverages and 
attributes in INFO tables. 
 

 
 
The Catalog makes it easy to organize your data. Delete a coverage by pressing the Delete key 
on your keyboard. Rename shapefiles and copy tables to another geodatabase just as you would 
rename and copy files with Windows ® Explorer. ArcCatalog makes it easy to start 
consolidating your spatial data into a coherent library that’s distributed across the network. 
 
If you’re a data administrator, the Catalog can help you create an environment in which 
geographic data can be easily used by everyone in your organization. Layers include a shortcut 
to the data and additional information such as symbology, percent transparency, queries that 
select specific features, and joins or relates that link attributes in external tables to the spatial 
data. You can create layers in ArcCatalog and place them in a shared folder on the network 
where everyone can access them. Others can add those layers to maps without having to know 
how to access the database, how to classify data, or even the format in which the data is stored. 
 
Similarly, you can customize metadata in the Catalog to include information that’s specific to 
your organization such as whether or not new coverages have passed quality assurance tests. 
You can also customize how metadata is displayed so the right information is presented to the 
right people in your organization. 
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Overall, ArcCatalog will revolutionize how you do your work. It makes accessing and 
managing geographic data so easy that before long it will be a constant companion on your 
desktop. 

3.1.2 What’s in the Catalog? 
On the left of the ArcCatalog window, you see the Catalog tree; it gives you a bird’s-eye view 
of how your data is organized. On the right are tabs that let you explore the contents of the 
selected item in the Catalog tree. 
 

 
 
The first time you start ArcCatalog, it contains folder connections that let you access your 
computer’s hard disks. The Catalog also contains folders that let you create and store 
connections to databases and Internet servers and manage geocoding services and search results. 
 
 
 

 
 
When you select a connection, you can access the data to which it’s linked. Folder connections 
let you access folders, or directories, on local disks or shared folders on the network. Database 
connections let you access the contents of a database. When you remove folder or database 
connections from the Catalog, you are only removing the connection, not deleting the data. 
 
Together, your connections create a catalog of geographic data sources. Individual folders and 
data sources are items in that catalog. If you use ArcInfo Workstation, you’re accustomed to 
using the term “item” when referring to a coverage’s attributes; in this book, "item" refers only 
to an element in the Catalog tree. 
 
The Contents tab 
When you select items such as folders or geodatabases in the Catalog tree, the Contents tab lists 
the items they contain. To change the appearance of the Contents list, use the appropriate 
buttons on the Standard toolbar. 
 

 
 
Large Icons view represents each item in the list with a large icon. List view uses small icons. 
Details view shows properties of each item in columns; you can sort the list by the property 
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values. Thumbnails view displays a snapshot for each item in the list, providing a quick 
illustration of the item’s geographic data. 
 
Items such as maps, shapefiles, and tables don’t contain other items. When you select them in 
the tree, the Contents tab lists the item’s properties and its thumbnail. Thumbnails give you a 
quick look at an item’s geographic data; they’re useful when browsing through folders. 
However, you must often see the data in more detail to determine whether or not you want to 
use it. 
 
The Preview tab 
The Preview tab lets you explore the selected item’s data in either Geography or Table view. 
For items containing both geographic data and tabular attributes, you can toggle between the 
Geography and Table views using the dropdown list at the bottom of the Preview tab. 
 

 
 
Geography view draws each feature in a vector dataset, each cell in a raster dataset, and each 
triangle in a TIN dataset. When drawing geographic data, the Catalog uses a default set of 
symbology. When drawing a layer’s contents, the Catalog uses the symbology stored in the 
layer. You can explore the selected items geographic data using the buttons on the Geography 
toolbar. 
 
Table view draws all rows and columns and the value for each cell in the selected item’s table. 
You can explore the values in the table using the scroll bars, the buttons at the bottom of the 
table, and the context menus that are available from the column headings. 
 
The Metadata tab 
The Metadata tab shows descriptive information about the selected item in the Catalog tree. 
Metadata includes properties and documentation. Properties are derived from the data source, 
while documentation is information provided by a person. 
 
Metadata is stored as extensible markup language (XML) data in a file with the data or in a 
geodatabase. The Catalog uses an extensible stylesheet language (XSL) stylesheet to transform 
the XML data into a hypertext markup language (HTML) page. You can change the metadata’s 
appearance by changing the current stylesheet using the dropdown list on the Metadata toolbar. 
To use within CIFOR, we suggest you to use the CIFOR Default stylesheet. 
 

 
 
You can browse through the available metadata just as you would browse through any Web 
page in a browser. 
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3.2 Building a catalog 
 
When you first open ArcCatalog, you see folder connections that let you access data on your 
computer’s local disks. Often, however, the data you use isn’t stored on your computer. You can 
build your own catalog of geographic data by connecting to other disks or folders on the 
network and adding connections to databases and Internet servers. You can also add file types 
and hide items that you don’t need for the moment. 
 
When all your data is in one place, you gain more than just an inventory. It becomes easier to 
find the data. And because you can work with all types of geographic data sources the same 
way, regardless of their format, your data becomes easier to manage. 
 
Start ArcCatalog 
To start ArcCatalog just simply use the following step. 
1. Click the Start button on the Windows taskbar. 
2. Point to Programs. 
3. Point to ArcGIS. 
4. Click ArcCatalog. The ArcCatalog window appears. 
 

 
 

3.3 Adding folder connections 
 
When you first start ArcCatalog, the Catalog tree has entries for your computer’s hard disks. To 
access data stored on a CD, floppy disk, or another computer on the network, you must add 
connections to those locations. A folder connection can point to any folder to which you have 
access. If only one folder in your computer’s C:\ drive, called “workshop_data”, contains GIS 
data, you don’t have to include the entire C:\ drive in the Catalog tree. Add a new connection 
that points directly to the C:\data folder, then remove the C:\ drive connection from the Catalog 
tree.  
 
A quick way to do this is to drag the C:\workshop_data folder from the Contents tab and drop it 
on the Catalog at the top of the Catalog tree. To quickly connect to folders that aren’t currently 
available in ArcCatalog, type the folder’s path into the Location text box and press Enter. If a 
shared folder is unavailable on the network the next time you start ArcCatalog, a little red ‘x’ 
will appear on the folder connection’s icon indicating that it is unavailable. The ‘x’ disappears 
when the connection is reestablished.  
 
In Exercise 2 you’ll learn how to 

 Connecting to a folder 
 Disconnecting from a folder 

 
Connecting to a folder 
1. Click the Connect To Folder button. 
2. Navigate to the “workshop_data” folder that you want to add to the Catalog. 
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3. Click OK. A new folder connection appears in the Catalog tree. 
 

 
 
Disconnecting from a folder 
1. Click the folder connection that you want to remove from the Catalog. 
2. Click the Disconnect From Folder button. The folder connection is removed from the 

Catalog tree. 

 
 

3.4 Adding and working with spatial database connections 
 
With ArcCatalog, you can explore and manage geographic data stored in an RDBMS through 
ArcSDE. Similarly, SDE for Coverages lets you access coverage, ArcInfo LIBRARIAN, and 
ArcStorm databases the same way you access data from an RDBMS. To access these spatial 
databases, you must add a connection to the Catalog. 
 
You aren’t required to type your username and password to create a connection; if you don’t, 
you will be prompted to enter them when a connection is established. However, you can type 
your username and password and create a test connection if you’re unsure whether the 
information you have is correct. If the connection test fails, contact the database administrator to 
ensure the database is operational. You can still add this connection to the Catalog but will be 
unable to retrieve data until the problem is resolved. After creating a test connection, uncheck 
Save name and password if you prefer not to save your login information as part of the 
connection. Choosing not to save login information as part of the connection can help maintain 
the security of the database. To make it easier to log in each time, create a connection for which 
you only have to enter your password each time; provide the server information and your 
username, then click OK. 
 
To understand how to connecting and working with spatial database try Exercise 3 below. 
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Connecting to a spatial database 
1. Click the Database Connections folder in the Catalog tree. 
2. Double-click Add Spatial Database Connection. 
3. Type the name or IP address of the server to which you want to connect. (Please refer to 

Appendix I for the connection properties) 
4. Type the name or port number of the service to which you want to connect. 
5. If the data is stored in a Sybase®, SQL Server™, IBM DB2, or Informix RDBMS, type the 

name of the data-base to which you want to connect. If the data is stored in another 
RDBMS, skip this step. 

6. Type your username and password for accessing the data. 
7. Click Test Connection. If the test was successful, the button becomes unavailable. If the test 

fails, you won’t be able to retrieve data until you’ve provided the correct information or the 
database problem has been resolved. 

8. Uncheck Save Name/ Password if you don’t want this information saved with the 
connection. 

9. Click OK. 
10. Type a new name for the database connection. 
11. Press Enter. 
 

 
 
Working with database connections 
Database connections are either connected or disconnected. All connections are disconnected 
when you start ArcCatalog. The first time a connection is selected, the Catalog attempts to 
connect to the database. If your login or version information isn’t saved with the connection, 
you’ll be prompted for it. When a connection is established, you can access the database’s 
contents. Database connections remain connected until ArcCatalog is closed or you can 
disconnect manually. You could make a local copy of the data and disconnect before editing it 
onsite. The strategy you choose for connecting and disconnecting affects the number of licenses 
available to others who must access the database. 
 
If the database is moved to a new computer, or the usernames and passwords for accessing its 
contents change, you must update your database connections, as well as the source information 
for layers that access data in that database, with the new connection information. 
 
1. Click the database connection you want to use. 
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2. If your login information isn’t saved with the database connection, a login dialog box will 
appear. Type the required information, and then click OK. The red ‘x’ disappears from the 
database connection’s icon. 

 

 
 
Disconnecting from a database 
1. Right-click the database connection that you want to disconnect. 
2. Click Disconnect. A red ‘x’ appears on the database connection’s icon. 
 

 
 
Repairing a database connection 
1. Right-click the database connection you want to fix and click Connection Properties. The 

appropriate dialog box appears for spatial or OLE DB database connections. 
2. Change the connection properties. For example, change your username and password. 
3. Click OK. 
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4 Working with metadata 

4.1 What is metadata? 
 
Metadata is information that describes your data in the same way a card in a library’s card 
catalog describes a book. After you create new data, you should create metadata to document its 
contents. When detailed metadata has been created, it can answer your questions and help you 
make decisions. For example, it can help you determine when your data is out of date, what map 
scale is appropriate for presenting your data, or how accurate your data is and therefore how 
much confidence you can have in your conclusions. 
 
Any item in the Catalog, including folders and file types such as Word documents, can have 
metadata. With the Catalog’s default settings, all you have to do to create metadata is click the 
item in the Catalog tree and click the Metadata tab the Catalog both creates metadata and 
records the item’s properties within it. Once created, metadata is copied, moved, and deleted 
along with the data source when it is managed with ArcCatalog or ArcInfo Workstation. 
 

4.1.1 Metadata in ArcCatalog 
Metadata in ArcCatalog consists of properties and documentation. Properties, such as the extent 
of a shapefile's features, are derived from the item itself. Documentation is descriptive 
information supplied by a person. 
 
By default, when you attempt to view an item’s metadata, ArcCatalog will create it 
automatically if metadata doesn’t already exist; it will then add many of the item’s properties to 
it. Hints about the documentation you should provide are also added. Once created, metadata 
becomes part of the item itself. It is automatically moved, copied, and deleted along with the 
item. 
 
Every time you view the metadata, the Catalog automatically updates the properties recorded in 
it with current values. This ensures that the metadata is kept up to date with changes to the data 
source. For example, the extent and count of a shapefile’s features will be current when you 
look at its metadata, even if new features were recently added. 
 
If you want more control over when metadata is created and updated, you have a few choices. 
You can turn off automatic updates for individual items for example, after they have been 
published. Then, you can choose to create and update metadata manually by clicking the 
Create/Update Metadata button on the Metadata toolbar. 
 

4.1.2 Writing documentation 
Documenting your data protects your organization’s investment in that data. Without 
knowledge of the data’s accuracy, provenance, and age, you can’t have a high level of 
confidence in decisions based on that data. Creating detailed metadata describing these qualities 
ensures that you can continue to use your data and make decisions based on it. 
 
In its simplest form, documentation might be a few lines in a text file. While better than 
nothing, this type of documentation may only be useful to the person who created it. For 
example, steps in the processing history may be omitted because they seemed obvious at the 
time. It is important that other people clearly understand your documentation particularly 
information describing how your data should and should not be used. 
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Because errors of omission and misinterpretation can be costly, efforts have been made to create 
standards for documenting spatial data. Standards range from simple to complex. Different 
states and countries have created their own standards to try to simplify and clarify the 
information that should be recorded. However, the proliferation of standards has caused 
confusion. 
 
Fortunately, the International Standards Organization (ISO) is creating a unified content 
standard. With a common standard it will be easier for those within an organization, as well as 
the GIS community as a whole, to create and use metadata. 
 
Simply because so many different standards exist, metadata in ArcCatalog isn’t required to meet 
any specific one. However, standards can be enforced by a metadata editor. The metadata editor 
provided with the Catalog lets you document your data following the FGDC standard. If you 
complete the documentation suggested by the Catalog’s hints, your metadata will satisfy the 
FGDC standard’s minimum requirements. 
 

4.1.3 How metadata is stored 
Metadata created with ArcCatalog is stored as XML data either in a file alongside the item or 
within its geodatabase. XML is a markup language similar to HTML. HTML defines both the 
data and how it’s presented. XML, on the other hand, lets you define data using tags that add 
meaning. 
 
Stylesheets define how XML data is presented. They are created using XSL. XSL elements 
query and evaluate XML data. A stylesheet retrieves specific values from an XML document, 
formats them, and then defines how they are presented. ArcCatalog stylesheets generate HTML 
pages from XML data. Therefore, you can interact with metadata as you would interact with any 
HTML page in a browser. 
 
Because the presentation information is stored separately, you can change the metadata’s 
appearance using different stylesheets. To change the stylesheet that is currently being used to 
transform the metadata, simply click a different stylesheet from the dropdown list in the 
Metadata toolbar. 
 

4.2 Creating metadata 
 
By default, metadata is automatically created or updated when you view it in the Metadata tab. 
However, you can choose to create and update all metadata manually. When you change these 
settings in the Options tab, it affects how metadata is handled for all items in the Catalog. You 
can turn off automatic updates for specific items using the Metadata Properties dialog box. You 
might do this after completing and publishing their metadata so it is not accidentally changed 
later. 
 
You can manually update an item’s metadata at any time by clicking the Create/Update 
Metadata button on the Metadata toolbar. Suppose that while you are viewing an item’s 
metadata, you modify its properties. Click the Create/Update Metadata button to have those 
changes reflected in the metadata. 
 
Exercise 4 will show you step by step on how to: 

 Create an Update metadata manually 
 Add documentation 
 Import and export metadata 
 Publish your metadata into an ArcIMS metadata server 
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Creating and updating metadata manually 
1. In the Catalog tree, click the item whose metadata you want to create or update. 
2. Click the Metadata tab. 
3. Click the Create/Update Metadata button on the Metadata toolbar. 
 

 
 

4.3 Editing metadata 
 
Your Catalog has been installed with a CIFOR Metadata Editor. To start using the CIFOR 
Metadata Editor, click the CIFOR Metadata Editor button on the Metadata toolbar. If you want 
to use other metadata editor, you just simply change your option on the Options dialog box. 
Although you can only use one at a time, you can use different editors to document your data. 
Because metadata for coverages, shapefiles, and other file-based data sources is stored as XML 
files on disk. 
 
Adding documentation 
1. Click the item whose metadata you want to edit in the Catalog tree. 
2. Click the Metadata tab. 
3. Click the CIFOR Metadata Editor button on the Metadata toolbar. 
4. Document your data using the metadata editor. 
5. Close the metadata editor. 
 

 
 
Choosing a metadata editor 
1. Click the Tools menu and click Options. 
2. Click the Metadata tab. 
3. Click the Metadata Editor dropdown arrow and click the editor you want to use. 
4. Click OK. 
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4.4 Importing and exporting metadata 
 
While you can create metadata in ArcCatalog, you may already have metadata that was created 
with another metadata tool. If it’s stored in the text, XML, or SGML format defined by the 
FGDC’s metadata parser utility, mp, you can import that metadata. ArcCatalog uses mp itself to 
import and export metadata in its supported formats; these are the FGDC CSDGM formats in 
the Format list. The XML format can be used to import metadata that was created with 
ArcCatalog. Importing overwrites all of an item’s existing metadata. 
 
Suppose you import metadata created with another application. By default, ArcCatalog updates 
as many metadata elements as possible with current values derived from the item such as the 
extent and coordinate system of its data. These values will be updated automatically every time 
you view the metadata. However, if you uncheck Enable automatic update of metadata, 
ArcCatalog won’t overwrite any existing values 
 
You might export metadata that is maintained by ArcCatalog to publish it on the Nadirs 
geospatial data clearinghouse. When exported to the FGDC CSDGM formats, the elements 
defined in the ESRI profile are excluded. Because ArcCatalog uses mp to create the resulting 
files, they can be posted directly on the clearinghouse. Exporting to the format "HTML" creates 
a file that represents the selected item’s metadata exactly as you see it in the Metadata tab. The 
format "XML" creates a copy of the item’s metadata in a new XML file. This lets you work 
with metadata for geodatabase items outside ArcCatalog. 
 
If your organization has defined its own metadata standard or a metadata database, you can 
create custom importers and exporters that translate between the Catalog’s XML and your 
custom format. You may want to do this if you want the Catalog to automatically maintain the 
metadata, but other applications require metadata in your format. Once registered with the 
Catalog, your importer or exporter will appear in the list in the Import or Export dialog box. 
 
Importing metadata 
1. In the Catalog tree, click the item for which you want to import metadata. 
2. Click the Metadata tab. 
3. Click the Import Metadata button on the Metadata toolbar. 
4. Click the Format dropdown arrow and click the format of the metadata that you will be 

importing. 
5. Click the Browse button. 
6. Navigate to and click the metadata file whose contents you want to import. Click Open. 
7. If you don’t want ArcCatalog to update the metadata with the current properties of the data, 

uncheck Enable automatic update of metadata. 
8. Click OK. The imported metadata appears in the Metadata tab. 
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Exporting metadata 
1. In the Catalog tree, click the item for which you want to export metadata. 
2. Click the Metadata tab. 
3. Click the Export Metadata button on the Metadata toolbar. 
4. Click the Browse button. 
5. Navigate to the folder in which the exported metadata should reside, type a name for the 

new metadata file, and then click Save. 
6. Click the Format dropdown arrow and click the format in which you want to export the 

metadata. 
7. Click OK. A new file containing a copy of the item’s metadata is created in the appropriate 

format. 
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4.5 Publishing metadata to an ArcIMS metadata service 
 
Anyone can publish an item's metadata as well as individual XML documents to any ArcIMS 
metadata service as long as they have permission to do so. However, for administration reasons, 
please contact GIS Unit to assist you in publishing metadata to an ArcIMS metadata service. 
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5 Forest Spatial Information Catalog (FSIC) 
 
If you know something about the data you are looking for, but you do not know where it is 
located, FSIC can help. The Forest Spatial Information Catalog (FSIC) is a tool for searching 
and browsing the contents of a metadata service. FSIC uses metadata to evaluate whether a data 
source satisfies your criteria. Having excellent documentation will be essential for people to be 
able to find the data they need. This is when metadata is especially important. 
 
Its architecture includes components for metadata generation (based on the FGDC standard), 
OpenGIS compliant Web Mapping and client side metadata searching and retrieving. The entire 
content of the database has been made available to authorized users; the searching and viewing 
of the metadata is open to everyone. 
 
It is provide with two ways of spatial data querying. First by typing one or more keywords on 
the search page and second by interactively selecting an area on the map. You can also use the 
“Advanced Search” to narrow your focus when searching for a catalog. 
 
For more information on FSIC, please visit FSIC at http://gislab.cifor.cgiar.org 
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Appendix I. Connection Properties 
 
For ArcView Database Access 
 
 Create a new connection 
  Using: SDE 
   
 Enter connection information 
  SDE Server:Instance: cifor2k03:port:5353 
  Username: gisuser Password: topo 
   
 Select a database name. 
  Database names: workshop 
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In ArcCatalog 
 
 Server: cifor2k03 
 Service: port:5353 
 Database: workshop 
 Account 
  User Name: gisuser 
  Password: topo 
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Appendix II. Workshop Group 
 
Group I 
 

1. Atiek Widayati  
2. Agus Salim 
3. Meilinda Wan 
4. Sonya Dewi 
5. Levania Santoso 
6. Tini Gumartini (Leave for Field Trip) 
7. Danan Hadi Prasetyo 
8. Haris Iskandar 
9. Herry Purnomo (Meeting) 
10. Iwan Kurniawan 
11. Jusupta Tarigan 
12. Hety Herawati 
 

Group II 
 

13. Ronny Syam  
14. Yuan Octavian 
15. Imam Basuki 
16. Miriam Van Heist 
17. Wil de Jong 
18. Brian Belcher 
19. Andree Ekadinata 
20. Heru Komarudin 
21. Hari Priyadi 
22. Yulia Siagian (Change to Group I) 
23. Nining Liswanti (Change to Group I) 
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Appendix III. Workshop Schedule 
 
Group I 
 
08.15 – 08.30 Introduction 
 
08.30 – 09.30 ArcView Database Access 

 Introduction to ArcView Database Access. 
 Make a map and add simple database themes 

 
09.30 – 10.30 ArcCatalog 

 Introduction to ArcCatalog 
 Building a catalog 
 Adding folder connections 
 Adding and working with spatial database connections 

 
10.30 – 11.30 Metadata 

 What is metadata? 
 Creating metadata 
 Editing metadata 
 Importing and exporting metadata 
 Publishing metadata to an ArcIMS metadata service 

 
11.30 – 11.45 Forest Spatial Information Catalog (FSIC) 

 Demonstration of FSIC 
 
Group II 
 
13.15 – 13.30 Introduction 
 
13.30 – 14.30 ArcView Database Access 

 Introduction to ArcView Database Access. 
 Make a map and add simple database themes 

 
14.30 – 15.30 ArcCatalog 

 Introduction to ArcCatalog 
 Building a catalog 
 Adding folder connections 
 Adding and working with spatial database connections 

 
15.30 – 16.30 Metadata 

 What is metadata? 
 Creating metadata 
 Editing metadata 
 Importing and exporting metadata 
 Publishing metadata to an ArcIMS metadata service 

 
16.30 – 16.45 Forest Spatial Information Catalog (FSIC) 

 Demonstration of FSIC 
 
 


